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Tutorial: Map design 

 
 

Designing a thematic map 

This detailed guide explains how the results of an 
analysis can be presented in a thematic map. We 
assume the existence of various data or analysis results 
and show how maps can be created using ArcMap 
(10.3, the analysis and visualization component of 
ESRI's desktop GIS ArcGIS). 

As data sets we use the charging stations (a point 
theme) and the results of the accessibility analysis (a 
polygon theme) on a municipal level. We combine this 
in front of a background map and illustrate which 
elements belong to a map and which signatures or color 
graduations can be used.  

The result - a combination of an overview map and a 
detailed map - can be seen on the right. 

 

Data preparation 
Compiling data 

Open ArcMAP and start with an empty map (see fig. 1). Then load all required data into the new 
ArcMap project. You can use the Add Data... option under File as well as the symbol  at the top 
left of the scale display. In addition to the starting point (in the example the location of the Faculty of 
Agricultural and Environmental Sciences (AUF)) and the charging stations - both point-shaped objects 
- a result of the accessibility analysis (in the example the accessibility within 5, 10 and 30 minutes 
based on the road network, i.e. polygon-shaped objects) should also be displayed in the map. Once 
these data sets have been loaded into the program, a suitable background map has to be selected. 
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Fig. 1: Selection of the start layout 

Topographical background  

Select background map  

The result of this guide will be a thematic map. Each thematic map requires a topographical 
background to locate the topics presented (in the example, accessibility zones and services offered at 
the charging stations). Either a single georeferenced raster map can be used as a background map or 
a web map service (WMS). WMS are services that make georeferenced maps available and are 
usually provided by the state surveying authorities (Further information can be found in our tutorial 
on OGC W*S). ArcMap also offers the option of selecting from various WMS provided by ESRI. The 
WMS available in ArcMap can also be called up and selected via File => Add Data => Add Basemap... 
or via the small arrow next to the above symbol. If another WMS is to be integrated, the service 
provider must first copy the appropriate URL. A list with available services for M-V can be found 
below:  

https://www.geoportal-
mv.de/portal/Geowebdienste/Fachthemen/Topographische_Karten_und_Luftbilder 

Integrate a WMS 

Then open the Add Data menu again in ArcMap and select Add WMS Server from the drop-down 
menu at the top. In the window that appears (see Fig. 2), enter the URL you just copied and use Get 
Layers to check whether the service works. Confirm with Ok. 

https://www.geoportal-mv.de/portal/Geowebdienste/Fachthemen/Topographische_Karten_und_Luftbilder
https://www.geoportal-mv.de/portal/Geowebdienste/Fachthemen/Topographische_Karten_und_Luftbilder
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Fig. 2: Integrating a WMS via URL 

Watch your step! If there are no other data in the ArcMap project yet, the displayed section is set 
to the maximum extent of the service. However, some services are only displayed in a limited scale 
range. If, for example, the WMS of the Digital Topographic Map 1:10000 is selected, it will not be 
displayed in the overall view of Mecklenburg-Vorpommern! The display window remains 
apparently empty. Only by zooming in the map becomes visible. It is therefore advisable to first 
load a data set corresponding to the area into the project and inserting the service afterwards. 

Map projection 

Depending on the background map, the map image may appear "squashed". This is because the data 
and the background map are in different coordinate reference systems (CRS). Further information on 
CRS can be found in our tutorial on Coordinate Reference Systems. In this example, the data are 
provided with a geographical coordinate system (polar coordinates in WGS84), while the official 
topographic maps are often created in Cartesian coordinate systems (such as UTM). This compresses 
the map graphic when it is necessary to reproject it. In order to avoid this, the ArcMap project can be 
converted to display Cartesian coordinates. The data itself is not changed by the re-projection. The 
use of geographical coordinates for the display despite a background map based on Cartesian 
coordinates is not wrong, but leads to limited legibility of the background map and thus to a worse 
cartographic display (see Fig. 3a and 3b). 

The change of the coordinate system used for the representation takes place in the properties of the 
data frame. Right-click on Layers (top entry in the table of contents on the left) to open a menu. The 
Properties... option opens a window in which the properties of the data frame can be edited. Under 
the Coordinate System tab in the upper window under the Layers entry you can see which coordinate 
systems are available in the project (see Fig. 4). 
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Fig. 3a: Compressed map image by display in a 
global coordinate system 

 

Fig. 3b: Normal map image by display in a 
suitable coordinate system 

 

Fig. 4: Overview of the coordinate systems already used in the project 

As an alternative to the coordinate systems listed there, you can select a suitable Cartesian 
coordinate system for the display from the Projected Coordinate Systems folder. To do this, select the 
corresponding entry and confirm with Apply at the bottom right. In order to ensure a correct display 
of all data levels, a suitable parameter set (usually the first entry in the drop-down menu) for the re-
projection should be selected for all other entries using the Transformations... option (see Fig. 5). 
These transformation parameters are necessary because the transition between different 
descriptions of the Earth figure underlying the coordinate systems (cf. e.g. Resnik/Bill, 2018 or Bill, 
2016) is based on complex mathematical calculations and depends on the area on Earth in which one 
is located. 
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Fig. 5: Selection of projection parameters 

Map design 

After the background map has been selected, we devote ourselves to the design of the thematic 
levels. In the present example, these are the AUF location as the starting point for the calculations, 
the locations of the charging stations and the services they offer, as well as the zones of accessibility 
based on the road network. It is therefore necessary to visualize point- and area-shaped objects. 
Both simple location information and thematic information (attribute values) are displayed. 

Point signatures 

In order to select a suitable design variant, it is first necessary to be clear which property of the 
objects is to be displayed. If it is only a matter of displaying a location, a simple position signature is 
sufficient (e.g. a simple dot). If, on the other hand, certain numerical values (numerical attributes of 
the objects) are to be displayed, it is better to use points of different sizes (so-called quantity 
signatures). If you want to display different types of point objects (e.g. different operators of the 
charging stations), you can work with differently shaped signatures (circle, triangle, square) or 
different colors (green, blue, red). Frequently, the design variables mentioned (e.g. shape and color) 
are also combined. 

Design options can always be found in the properties of the respective data level. Right-click on the 
level and select Properties... to open the menu. The Symbology tab contains the display methods. 
Different methods are offered depending on the geometric characteristics of the data. On the left 
there is a list of the available options, whereby the picture below gives a first impression of the 
currently selected display method (but related to surface objects). 

Point map characters 

A simple position signature is recommended for the representation of the starting point of the 
accessibility analyses. This does not necessarily have to be a simple geometric figure. It is also 
possible to design pictorial signatures. The option "Position signature" can be found in this menu 
under Features => Single Symbol and is usually selected by default (see Fig. 6). The shape of the 
position signature can be edited by clicking on the suggested map symbol under Symbol. 
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Fig. 6: Determination of the presentation method 

The Symbol Selector menu opens. Here you can choose from a number of predefined signatures. You 
can also change the color and size of the figure on the right (see Fig. 7). By clicking on the Edit 
Symbol... option, extended design options can be used.  

 

Fig. 7: Signature selection for point type objects 

The Symbol Property Editor menu offers a wide range of design options. The example shows how 
more complex map characters can be designed. To do this, set the Type Character Marker Symbol at 
the top center (see Fig. 8). 
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Fig. 8: Extended signature processing  

"Character Marker Symbols" are map characters that are organized similar to a font. They form, so to 
speak, the "letters" of the font. The installation of ESRI ArcGIS contains some thematically sorted 
fonts with card characters. For example, the font "ESRI Environmental & Icons" contains some 
pictorial map characters. If a map character is selected from the font, its size and color can be set to 
the right. On the left is a preview of the finished map character and an overview of the map 
character structure. A map sign can be joined from several layers. This is necessary, for example, to 
provide it with a frame and a background area.  

In this example, the hut symbol has been selected for the location. However, it consists of lines 
without filling and will therefore be difficult to see on the map. To improve readability, another layer 
is added to provide a background area. For another layer in the map character structure the + sign is 
clicked at the bottom left. The newly added layer is by default a simple black filled area, which lies 
above the first selected map character and thus hides it. The order within the structure is controlled 
using the arrow keys at the bottom left. Move the area under the hut symbol. The area also comes 
from a map character font. There you can choose between different geometric shapes. The first 
group of characters are filled surfaces, the second group are only surface outlines (see Fig. 9). Select 
a suitable shape from the first group, which has a counterpart in the second group, e.g. the circle. 
Give the circle a different color so that the preview shows whether the area is large enough for the 
hut symbol. In the map, a white background color may be a good way to make the map symbol stand 
out from the map background, but it's a good idea to choose a clearly visible color first when 
selecting the area size. 

Once the size and shape of the background area has been defined, another layer can be added to 
add a border line to the map character. To do this, add another layer and select the shape that 
corresponds to the previously selected surface shape from the second group of characters. The 
frame layer does not have to be moved in this order. Adjust the size so that the background area and 
frame fit perfectly. Confirm the changes to the map character with Ok and return to the properties 
menu of the location layer. Since each object of this data layer is displayed with the same map 
character, the explanatory text that appears in the legend can be entered in the free box directly 
below the map character in the Legend section. Spaces and special characters are allowed. 
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Fig. 9: Design of a multi-layer map character 

Representation of qualitative characteristics 

For the display of the charging stations, entries from the attribute table of the data set should be 
used. Open the properties menu for this level as well. The charging stations are provided with 
information on the service offered. However, this data is not entered in the form of a numeric 
attribute, but as a textual description. For this reason, display methods for quantitative data (size 
variation, color scale) are not available. It would be possible to create a numerical attribute in the 
data set and fill it with the corresponding values, but then it would not be possible to identify 
stations that offer different power levels. Therefore, in this example, a representation according to 
qualitative characteristics will be made.  

The corresponding presentation method can be found in the Categories group. The Unique values 
option is used to display data broken down by an attribute value. The corresponding attribute needs 
to be selected under Value Field (top center). In the example data record, this attribute is 
"amperage". To insert all values from the table click on Add All Values in the lower left corner. Now 
all different values from the table are listed. This way you can be sure not to forget any value or 
notice errors in the data set (e.g. typing errors during input or missing values). In this example, most 
charging stations are without an entry for the power provided. For the explanation of the different 
map characters in the legend it is recommended to reformulate the entry from the attribute table or 
to describe it textually. The second column in the overview is used for this (Label). There you can 
simply click in and type in the appropriate text (spaces and special characters are allowed). For 
entries without a table entry, for example, "no specification" can be used. Entries 16 and 16A can be 
combined. Both entries are marked and the option Group Values is selected after right-clicking. The 
explanatory text can then be reduced to one entry. The number entries can then be given the 
addition kW (for kilowatts). 

Design of the point categories 

Once the texts have been edited, we devote ourselves to the graphic design of the point categories. 
By clicking on the map symbol at the beginning of a line, the already known Symbol Selector menu is 
called up. Here you have the same possibilities to edit the map symbol as for the location display. It is 
recommended to distinguish the categories by color and to choose the same form for all. The point 
selected by default is best suited for this because it takes up little space on the map, but its color is 
still easily recognizable. The color selection should support the thematic statement of the data. It is 
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recommended to use a colour scale that runs from low (16 kW) to high (43 kW) intensity, e.g. from 
yellow to orange to red. The stations without information should be clearly separated from this, e.g. 
blue. 

Since a design is now defined for all objects in the data set, the check mark in front of <all other 
values> in the upper left corner can be removed. If the check mark remains, an extra entry is 
generated in the legend, although this map character does not appear in the map (see Fig. 10).  

 

Fig. 10: Defining the display and legend texts 

Polygon map characters 

The design of the area-wide accessibility zones also begins in the properties of the data level. The 
minimum and maximum time required to reach the zone from the starting point is stored in the 
attributes of the surfaces. For the sake of simplicity, the maximum time (attribute ToBreak) should be 
used for the display. Technically, this attribute value is numeric and can be used as a basis for 
classifications and color scales. However, there are only three different numerical values whose 
assignment is identical to the geometric division of the zones. It is therefore also possible to treat the 
attribute values as qualitative categories, i.e. as for the performance characteristics of the charging 
stations described above. 

If the attribute values are regarded as quantitative data, the Quantities => Graduated Colors category 
is selected in the method overview on the left. The underlying attribute ToBreak is selected at the 
top center under Fields. You can now select a color scale (Color Ramp), which defines the suggested 
colors for the three classes. However, these colors can easily be adapted to your own ideas. For 
quantitative data it is possible to classify them according to different methods. The "Natural Breaks" 
classification selected by default is suitable for finding suitable class boundaries for a data set. In the 
present case, the method confirms the selected time limits for the accessibility analysis. Also with 
this presentation method, the explanatory texts for the legend can be entered in the Label column 
on the right and the colors of the categories can be selected on the left (see Fig. 11). 
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Fig. 11: Representation using a color scale 

When designing the accessibility zones, it should be noted that a simple colour filling hides the 
background map underneath and thus severely limits the information content of the map. It is 
therefore recommended to use hatching or only contour lines. Theoretically, it would also be 
possible to make the areas semi-transparent, but this can cause other display problems because 
overlaying them with other colored areas changes the color effect and thus makes it more difficult to 
assign them to legend entries. 

Clicking the color boxes opens the already known Symbol Selector, this time with a selection of 
predefined surface designs. If only the outline is to be displayed, simply set the Fill Color to No Color 
on the right and select the outline color from the color chart. With this representation it is 
recommended to increase the width of the line (Outline Width) (e.g. to 2 pt).  

The Edit Symbol... option is selected for defining a hatch. The Symbol Property Editor icon that opens 
resembles the menu used to design the more complex map character for the location (see Figure 12). 
On the left there is a preview and the display of the structure of the surface design and at the top 
different types of surface designs can be selected (Type). Simple Fill Symbol stands for simple colored 
areas. The category Line Fill Symbol offers hatching. For hatching, the inclination of the lines (Angle), 
the distance between the lines (Separation), as well as the line type (Line...) and line color can be set. 
Offset controls a shift of the lines to avoid overlapping. Even hatched areas have an outline that can 
be designed independently of the hatching lines. This can be defined under Outline... . The hatching 
density should not be too high with regard to the use of a detailed map for the enlarged 
representation of the inner city area. Increasing the line spacing helps to reduce the map load 
(density of the graphic elements in the map). 
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Fig. 12: Definition of hatching parameters 

Map design layout 

After having defined a display method for all map objects, we devote ourselves to the compilation of 
the map layout. To do this, we switch to the layout view - either via the symbols below the map view 
(2nd from left) or via the menu bar at the top under View => Layout View. 

The default map layout is A4 portrait. The map image fills the entire sheet (see Fig. 13). The size and 
orientation of the map sheet can be changed under File Page and Print Setup... . 

To avoid having to place the map edge elements within the map image, it is advisable to reduce the 
size of the map image. To do this, you should first determine the scale of the map. In addition to the 
available space, a possible comparability with other maps (e.g. in a map series) plays an important 
role. A "round" value, such as 1:10 000 or 1:25 000, is usually used as the map scale. 

The scale can be entered at the top below the upper menu bar. For this example, a relatively small 
scale should be selected to represent the entire accessibility area. At the same time, however, the 
high density of map characters in the centre requires a rather large scale in order to obtain a clearly 
legible map image. With such conflicting requirements it can be useful to insert an additional so-
called detailed map (with a significantly larger scale). 
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Fig. 13: Original card layout 

Overview map 

So let's first define the scale for the overview map. In order to see the zones completely, it is helpful 
to right-click on the corresponding layer in the table of contents on the left and select the Zoom To 
Layer option. In the scale window at the top, the current scale is displayed. Since the map image has 
to be reduced in total, the final scale will be smaller than the one shown above, so the number 
behind the colon will increase. As start the scale 1:500 000 can be tested. Adapting the map frame to 
the area to be displayed can sometimes be complicated if the following recommended sequence of 
steps is not followed. Especially if the background map is a map that is only cut to the area and white 
stripes quickly appear at the edge of the map if the frame is not exactly adjusted, it is essential to 
follow the sequence:  

Step 1: Set scale 

 This makes it clear how large the map image will be. 

Step 2: Click on the map frame (You can click on the map without any problems). It is not necessary 
to click directly on the frame line.) 

 The frame should now be dashed in light blue with boxes at the corners and centers of the frame 
lines. 

Step 3: Switch to the move tool. (White hand, Pan)  

Step 4: Fit a corner of the intended map section into a corner of the frame (e.g. top left).  

Step 5: Switch back to the normal black mouse pointer (same toolbar as the Move tool). 
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Step 6: Go to the corner directly opposite the corner fitted in step 4 (in our example bottom right). 
The mouse pointer over the box changes to a diagonal arrow. Grab the corner with the mouse and 
drag it to the corner of the desired map section (If you are using a WMS as background map, you may 
have to allow for space for the automatically displayed source information). Do not release until the 
corner is correctly positioned! 

 The map section will move automatically when the mouse button is released and is not where we 
want it to be for the time being. 

Step 7: Switch back to the move tool and this time fit the map section into the corner just set with 
the mouse pointer (in our example bottom right). 

 The frame should now be completely filled out with the desired map section. 

Step 8: Switch back to the normal black mouse pointer. 

 The frame including the map picture can now be moved freely on the map sheet. 

Help lines can be used to position the elements on the map sheet. A guide line is created by clicking 
in one of the side rulers. For example, to center the map image on the sheet, create an auxiliary line 
in the upper side ruler and move it to 10.5 cm. (An A4 sheet is 21 cm wide.) If you now click on the 
map image and thus the frame, the boxes on the frame line act as snap-in positions for guide lines 
and the map image can be placed in the middle of the sheet (see Fig. 14). 

 

Fig. 14: Size adjustment and positioning of the map image 

Detailed map 

Before we dedicate ourselves to the map edge elements, we first insert the detailed map for the 
closer surroundings of the starting position. For this we need another data frame. In principle, the 
data frame is a container in which data levels are located. In the table of contents it appears as layers 
and contains the different data layers and the background map. In the map layout, the data frame is 
the frame line, which we adapted to our desired map section in the previous step. The data frame 
contains the administration and display of the coordinate systems available in the project. A new 



 

Professur für Geodäsie und Geoinformatik 
Dr.-Ing. Annette Hey 
Prof. Dr.-Ing. Ralf Bill 

 

 
Agrar- und Umweltwissenschaftliche Fakultät ● Justus-von-Liebig-Weg 6 ● 18059 Rostock 

data frame is inserted under Insert => Data Frame. Another entry appears in the table of contents 
and another frame in the map layout (see Fig. 15). 

Watch your step! For all further steps, please note that they are only applied to the active data 
frame. The active data frame is marked by a light gray, torn border line. Activation can be done 
either by clicking in the map layout or by right-clicking on the data frame in the table of contents 
and selecting the Activate option. The new data frame is now filled with the same data layers as 
the original one. Pay attention to the order of the data levels! The point like data should always be 
above the area data in order not to hide any information. The order of the data layers can be 
changed by simply moving the mouse. 

 

 

Fig. 15: Inserting the detailed map 

Since only one legend is to be created for both maps, the design specifications for the levels of the 
overview map must be transferred to the levels of the detailed map. This can be done without much 
effort. Open the properties menu of the corresponding data layer in the data frame of the detailed 
map (right-click Properties... or double-click on the layer) and select the option Import top right 
under the tab Symbology. Now all you have to do is select the appropriate layer from the overview 
map and, if necessary, the appropriate attribute (see Fig. 16). If it is not a Single symbol display (i.e. 
not only one map character is defined for all objects), the legend texts are also adopted. 
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Fig. 16: Acceptance of presentation specifications 

For the detailed map, the scale and map section must now be set. The zoom tool can be used for this. 

Watch your step! When working in the layout view, two navigation toolbars (each with zoom in, 
zoom out and pan tools) are available. The navigation tools from the layout toolbar control the 
view of the map sheet (see Fig. 17). 

 

Figure 17: Layout Toolbar 

The tools from the standard navigation bar control the view of the data and change the scale when 
enlarging or reducing (see Fig. 18). 

 

Fig. 18: Standard toolbar (Tools) 

In this example, the area depicted in the detailed map can be easily found in the overview map. If 
there is a large difference in scale between the two maps, this is usually not the case. Then the area 
can be marked in the overview map, which is shown in the detailed map. This is done in the 
properties of the data frame of the overview map (right click on Layers Properties... or double click 
on Layers). Under the Extent Indicators tab, the data frame of the detailed map can be selected on 
the left and moved to the right window with the arrow. The border of the area can be designed 
under the option Frame... (see Fig. 19). 
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Fig. 19: Marking of the detailed map extension 

Map edge elements 

In addition to the actual map image, the so-called map edge elements also belong to a complete 
map. These include the map title, the legend, a scale (numerical and/or graphical), an indication of 
spatial orientation (coordinates and/or north arrow) and the imprint (with information on map 
processing, creation date, author and, if applicable, data origin). Most of these elements can be 
inserted via the Insert menu in the upper menu bar. 

Map title 

The map title contains information on the topic depicted (What), the spatial location (Where) and, if 
relevant, the time depicted (When). For our example, the map title could be "Electromobility in 
Rostock". Insert => Title is a separate function for entering the map title (see Fig. 20). 

 

Fig. 20: Entering the card title 

The generated text field can be placed freely in the card layout and edited afterwards. Double-click 
on the text field to open the editing menu. There you can change the text as well as the alignment 
(see Fig. 21). 
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Fig. 21: Processing the card title 

If the font and font size are to be changed, a further Symbol Selector menu is available under Change 
Symbol... (see Fig. 22). This is similar in structure and function to the Symbol Selector menus already 
used for the point and area-shaped map characters. 

 

Fig. 22: Defining the font attributes 

Our map layout now contains the two map images and the map title (see Fig. 23). 

 

Fig. 23: Map layout after inserting the map title 
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Legend 

A first impression of what the legend will look like can be found in the table of contents of the 
project on the left. For our example, it doesn't matter which data frame is used to create the legend. 
Under Insert => Legend... you will find a tool for creating the legend. In the first step, the data levels 
to be explained are selected. By default, from the layers available in the project (left window) those 
for the legend are selected (right window) which are visible (check mark in the table of contents). 
WMS are excluded from the explanation in the legend. The same applies to raster maps, which may 
be used as background maps. Raster data of this type do not contain any objects that could be 
explained in the legend. If layers are to be added to or removed from the legend (i.e. moved 
between windows), the arrows between the windows are used (see Fig. 24).  

The order of the entries within the legend can be adjusted using the arrows on the right. The order 
depends primarily on the thematic meaning and geometric characteristics. The main theme of the 
map is prefixed. In the case of different geometries, the points, then the linear and finally the 
polygonr map characters are explained first. At this point, the legend can be divided into several 
columns. The number of columns can also be adjusted later and depends on the available space. 
Overall, the legend should be well structured and legible. 

 

Fig. 24: Legend creation - step 1 

In the second step, the legend heading is defined. We recommend to name it "Legend" or 
"Explanation of symbols" (see Fig. 25). 
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Fig. 25: Legend creation - step 2 

In the third step, a frame line and a background color can be selected (see Fig. 26). The border line is 
helpful if the legend is to be separated from other map border elements. The background color is 
necessary if the legend is to be placed within the map image. The color should be either white or 
gray. All other colors would lead to a falsification of the colors of the map characters to be explained 
and would make the interpretation of the map unnecessarily difficult. The Drop Shadow option is a 
graphical gimmick and should not be used for scientific maps. 

 

Fig. 26: Legend creation - step 3 

In the fourth step, the shape of the sample map characters in the legend for linear and polygon map 
characters can be changed. For example, it may be useful not to display a stream as a straight line as 
is the case by default, but to indicate a natural watercourse (Flowing Water). Other available options 
are not recommended for linear map characters. There are several options for area-based map signs 
which can be used sensibly. Water Body can be used for water bodies and Natural Area for areas that 
do not cover the whole area (see Fig. 27). The Ellipse and Diamond options, on the other hand, are 
not recommended under any circumstances. In this example, the standard legend boxes are a good 
choice. 
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Fig. 27: Legend creation - step 4 

In the last step, distances between individual legend elements can be set (see Fig. 28). The given 
values usually lead to a good result. 

 

Fig. 28: Legend creation - step 5 

The automatically generated legend still requires some manual post-processing (see Fig. 29). First, 
the names of the data levels interfere. They are not suitable as subheadings. Furthermore, the 
attribute names are superfluous. 
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Fig. 29: Automatically generated legend 

The postprocessing of the legend is generally done in the properties menu of the legend. This menu 
can be opened either by double-clicking on the legend or by right-clicking and selecting the 
Properties... option. Under the Items tab, you can edit the design of individual legend entries. The 
basic structure of the legend can also be changed here. If the legend is to be divided into several 
columns, you can determine here with which entry a new column is to begin. To do this, the 
corresponding entry is marked on the left and a check mark is placed at the bottom of the Item => 
Columns area in front of Place item(s) in a new column. If a legend entry consists of many rows, it can 
be divided into several columns. The number can be set at the bottom (see Fig. 30). 

 

Fig. 30: Menu for editing the legend structure 

The inappropriate "subheadings" can be converted to structure the legend. Only the font size of the 
subheadings has to be considered. In this example the attribute names are used because they are 
smaller. It is therefore necessary to remove the names of the data levels from the legend and to 
change the display of the attribute names in the legend to meaningful subheadings. To do this, open 
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the legend properties menu again. Under the Items tab, select the level of the charging stations on 
the left and click the Style... option at the bottom. In the Legend Item Selector that opens, various 
arrangement patterns for legend objects are available for selection. We ignore them and take the 
Properties... option. Now, under the General tab, the display of the names can be adjusted by 
removing or setting check marks. Layer Name is the name of the data layer, Heading is the attribute 
name and Labels are the explanation texts. In our example, the check mark in front of Show Layer 
Name is removed (see Fig. 31).  

 

Fig. 31: Hiding various text elements in the legend 

Confirm the change until you are back in the properties menu of the legend and carry out the same 
steps for the accessibility level. 

 

Fig. 32: Legend without display of data level names 

The attribute names are adapted in the table of contents of the project on the left. This is a purely 
cosmetic change. The actual data in the attribute table remain unchanged. Select the amperage 
attribute of the charging stations by clicking on it. Then press F2 and enter the desired text, e.g. 
"Charging station power". Repeat the steps for the Availability attribute. The design of the legend is 
now complete (see Fig. 33). 



 

Professur für Geodäsie und Geoinformatik 
Dr.-Ing. Annette Hey 
Prof. Dr.-Ing. Ralf Bill 

 

 
Agrar- und Umweltwissenschaftliche Fakultät ● Justus-von-Liebig-Weg 6 ● 18059 Rostock 

 

Fig. 33: Legend with customized subheadings 

 

Fig. 35: Map layout after inserting the legend 

Coordinate system 

It is sufficient to choose either the display of the coordinate system or the marking of the north 
direction. Neither is necessary if the map is north oriented. In ArcMap, maps are oriented north by 
default. This can be changed in the properties of the data frame (right click on Layers Properties...) 
under the tab General, e.g. if the displayed area fits better on the map sheet. The rotation is entered 
in the Rotation field (see Fig. 36). 
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For this example, both coordinates and north direction are given at least for the overview map. Let's 
start with the coordinates for the overview map. These are bound to the data frame and are set in its 
properties menu under the Grids tab. New Grid... creates a new coordinate system for the display. 
Different coordinate systems can be combined in a map, e.g. a cartesian system like UTM and 
geographical coordinates. 

 

Fig. 36: Changing the map orientation 

ArcMap offers three different types of coordinate displays:  

- Graticule for geographic coordinates,  

- Measured Grid for Cartesian coordinates and  

- Reference Grid for search grids (as often found on city maps, for example).  

For our example, we select Measured Grid (see Fig. 37). 

 

Abb. 37: Design of the coordinate display – step 1 
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In the second step, you define how the map is to be displayed. There are three options to choose 
from:  

- Labels only, if only the coordinates at the edge are to be specified,  

- Tick marks and labels if, in addition to the coordinates at the edge, small crosses should appear at 
the intersections of the labeled coordinate lines in the map and  

- Grid and labels if the labeled coordinate lines are drawn through.  

The selection should be based on how high the map load already is and what the purpose of the 
coordinates is. For maps, which should allow a precise position determination, solid coordinate lines 
are necessary.  

Below the three display options, the intervals between labeled coordinate lines can be defined. You 
should make sure that the interval size is easy to estimate and that it is the same in the X and Y 
directions. Suitable interval sizes are e.g. 250m, 500m and 1000m. It is best to round off the 
proposed values, which are suggested by the program on the basis of the scale and the extent of the 
area (see Fig. 38). 

 

Fig. 38: Design of the coordinate display - step 2 

In the third step, the line thickness and font for the coordinates at the edge of the map can be 
specified (see Fig. 39). Experience has shown that no adjustments are necessary here. 

 

Fig. 39: Design of the coordinate display - step 3 
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In the last step, the map frame can be changed to display coordinate intervals in the form of 
differently designed line segments (Measured Grid Border). In addition, an outer frame line can be 
placed around the entire coordinate label (neatline). Due to the very limited space available in the 
example map, we will not do this here.  

Under Grid Properties you can define how the coordinate display is to be saved (see Fig. 40). By 
default it is fixed to the data frame (fixed grid) and cannot be changed manually. This sometimes 
leads to problems if individual coordinate labels are to be moved or deleted. However, this always 
ensures that the coordinates are correct, since they are automatically moved when the map section 
is moved. Only in absolutely exceptional cases the option of saving as a simple graphic (static 
graphic) should be selected. This is easier to edit manually. However, no changes may be made to 
the map section. This also includes switching to the data view and back! 

 

Fig. 40: Design of the coordinate display - step 4 

Finish completes the creation. The resulting coordinate display is still inadequate. The zeros displayed 
after the decimal point are superfluous (see Fig. 41). 

 

Fig. 41: Automatically generated coordinate display 
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Changes to the coordinate display are made in the same place as the creation. Select the coordinate 
grid you just created and choose Properties... on the right. Under the Labels tab, select the Additional 
Properties... option (see Fig. 42). 

 

Fig. 42: Legend postprocessing - step 1 

In the next window we select the Number Format... option (see Fig. 43). 

 

Fig. 43: Legend postprocessing - step 2 

The next window then allows the elimination of decimal places (Number of decimal places = 0; see 
Fig. 44). 

 

Fig. 44: Legend postprocessing - step 3 
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The deficiencies in the coordinate display should thus be corrected (see Fig. 45).

 

Fig. 45: Corrected coordinate display 

North arrow  

The North Arrow... option is available in the Insert menu for inserting a north arrow. Similar to the 
definition of the map characters, the North Arrow Selector provides various ready-made north 
arrows and wind roses (see Fig. 46). The selection of a suitable north arrow can usually be made on 
the basis of personal taste. Only the suggested variants with shadow casting (as they can be found at 
the end of the selection) are not advisable, as they are very difficult to read. 

 

Fig. 46: Selection menu for north arrows and wind roses 

Since the orientation of the north arrow is directly connected to the (active) data frame, the display 
is always correct. Since the map sheet has very little space and the overview map contains larger 
areas without important map content, the north arrow can be placed directly in the map image (e.g. 
in the water areas in the northwest). Also insert a north arrow for the detailed map (see Fig. 47). 

Scale bar 

The scale can be specified both in graphical and numerical form. While a graphical scale always 
changes with the map (e.g. with enlargement or reduction) and thus remains valid, a numerical scale 
is always bound to the original output size. For both variants there is a corresponding option in the 
Insert menu. The scale is always bound to the data frame that is active when it is created. Within the 
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ArcMap project, the scale specification is always correct. Let's start with the graphical scale (scale 
bar). 

 

Fig. 47: Map layout after inserting the coordinates and marking the north direction 

The Scale Bar Selector offers a selection of predefined scale bars similar to the previous Selector 
menus (see Fig. 48). These can then be adapted to the requirements of the map. Here, too, the 
selection can be made on the basis of personal preferences. Only the selection options with the step-
like design (Stepped Scale...) is less suitable, since the broken line is a hindrance if you want to 
estimate distances taken from the map by applying them to the scale bar (which is the main purpose 
of a graphical scale). 

 

Fig. 48: Selection menu for scale bars 

The scale bar automatically generated after selection is correct in any case, but in most cases still not 
suitable for use (see Fig. 49). 
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Fig. 49: Automatically generated scale bar 

The criticisms of this automatically generated scale bar are as follows: The scale is not metric, the 
scale division is completely unsuitable for estimating points between the labelled values, and the 
additional division at the beginning of the bar leads to illegibility in the labeling. The scale bar can be 
edited in its properties menu (right-click on the scale bar => Properties... or double-click; see Fig. 50). 

 

Fig. 50: Finishing the scale bar 

The underlying unit of the scale bar is defined under the Scale and Units tab. In the lower area a 
metric unit is selected in the drop-down menu Division Units. Depending on the map scale, 
kilometers or meters are favorable. In this example, kilometers make more sense due to the rather 
small scale. Depending on the installed language package, the inscription must still be adjusted after 
the unit of measurement has been defined. The most space-saving option is to shorten the unit to 
the usual abbreviations, in this case "km". After these specifications, it is recommended to select the 
Apply option in order to be able to see the result of the change immediately before the scale division 
is revised (see Fig. 51). 

 

Fig. 51: Scale bar after changing the unit of measurement 

The scale division can be changed either by manually lengthening or shortening the scale bar or via 
the menu. Since the former generally requires several iterations, the latter is recommended. To do 
this, select the option Adjust number of divisions in the tab Scale and Units in the upper drop-down 
menu When resizing... . Now the size of a unit (division value) can be defined. In the example a size of 
10 km leads to a good result (see Fig. 52). 
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Fig. 52: Scale bar after adjustment of interval size 

By changing the scale division, the problem of poorly legible lettering has also been solved. Now the 
scale bar has to be placed in the map layout. Since there are two map images with different scales 
and the overall space is quite limited, it is recommended to place the scale bar directly into the map 
image again. But for this it needs a frame line and a background to ensure a good legibility. In the 
Properties menu under the Frame tab, you can set both a border line and a background area in a 
similar way to creating legends. The same hints apply here as for legend creation (white background 
if possible, no shadow cast). In order to ensure sufficient space between the frame line and the 
caption, it makes sense to define a buffer (gap) (see Fig. 53). Experience shows that this should be 
slightly larger in the x-direction than in the y-direction. 

 

Fig. 53: Definition of frame and background 

If the exact placement is made more difficult by docking to the guide lines, it is helpful to enlarge the 
map section (using the Layout toolbar tools!) and use the arrow keys. 

A Selector menu is also opened for inserting the numerical scale (Insert => Scale Text...). In addition 
to the simple 1:x variant, various variants including units are also available here (see Fig. 54). The 
numerical values suggested there serve only as an example and are always adapted to the actual 
map scale. When selecting the simple variant, nothing else needs to be considered. However, if a text 
in the style "1 cm in the map corresponds to x km in reality" is to be inserted and the language 
setting is not German, it is recommended to first use the menu to generate the text field and then to 
use the numerical values from it for a self-generated text field in the correct language. 
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Fig. 54: Selection menu for numerical scale texts 

Watch your step! The automatically generated text field is relatively small. It is usually placed in 
the middle of the current image section. From there it can be moved to the desired position with 
the help of the normal mouse pointer. A frame line and a background area can also be created for 
the numerical scale. This option can be found in the Properties menu (right-click on the Scale 
Properties... or double-click) under the Frame tab (see Fig. 55). If in the overview map the water 
area is used for the placement, neither frames nor background are necessary. 

 

 

Fig. 55: Definition of frame and background 

Then insert a graphic scale for the detailed map as well. Note that the data frame of the detailed map 
must first be activated for this (see Fig. 56). 
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Fig. 56: Map layout after inserting the scale displays 

Imprint 

The imprint contains information on map processing, the date of production of the map and, if 
applicable, the origin of the data used. It is inserted into the map as a simple text field (Insert => 
Text). By default, the automatically generated text field is located in the middle of the current image 
section. The blue dotted border indicates that the field is active and can be moved. An inactive text 
field (without border) is activated by clicking on it. Drag the text box to a neutral background to make 
the text easy to read. The text content and the font attributes (font, font style, font size) are adjusted 
in the Properties menu of the text field (right-click on the Properties... text field or double-click) (see 
Fig. 57; see also the section on the map title). 

 

Fig. 57: Editing the text field 
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Our map is now complete (see Fig. 58). 

 

Fig. 58: Finished map layout 
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